
 

 

 
 

 
fluency direct 

C L I N I C I A N ’ S  G U I D E  
 

 

 

 

FEBRUARY 2012 
VERSION 7.71 

 
DO NOT DUPLICATE 

  



 

 

C O N F I D E N T I A L I T Y  D I S C L A I M E R  

All information methods and concepts contained in or disclosed by this document is confidential and 
proprietary to Multimodal Technologies Inc.  By accepting this material, the recipient agrees that this 
material as well as the information and concepts contained therein will be held in confidence and will not 
be reproduced in whole or in part without express written permission from Multimodal Technologies, Inc.  
Client use of M*Modal tools or information (excluding any services or tools provided to the Client that are 
covered under a separate written agreement) is subject to the terms of a legal agreement between the 
Client and M*Modal. 
 
Inquiries regarding permission for use of material contained in this document should be addressed to: 
communications@mmodal.com 

 

C O N T A C T  I N F O R M A T I O N  

B U S I N E S S  

M*Modal Corporate 
9009 Carothers Parkway, Ste C-2  
Franklin, TN 37067 
 
M*Modal Pittsburgh 
1710 Murray Avenue 
Pittsburgh, PA 15217 

S U P P O R T  

M- F 8:00am - 5:00pm EST 
Languages Supported: English 
 
24/7 Support Hotline: 412-579-6001 (for Production clients only)  
Support Email: CompanyName.Support@mmodal.com  
Support Portal:  https://clientservices.mmodal.com 

  



 

 

T a b l e  o f  C o n t e n t s  
 

WELCOME .................................................................................................................................................... 1 
OVERVIEW ............................................................................................................................................... 1 

Benefits .................................................................................................................................................. 1 
REQUIREMENTS .................................................................................................................................. 1 
About This Guide ................................................................................................................................... 1 

GUIDE CONVENTIONS ............................................................................................................................ 2 
GETTING STARTED .................................................................................................................................... 3 

OPENING FLUENCY DIRECT .................................................................................................................. 3 
SIGN IN ..................................................................................................................................................... 4 

FLUENCY DIRECT WORKSPACE .............................................................................................................. 4 
THE CONTROL BAR ................................................................................................................................ 5 
FLUENCY EDITOR ................................................................................................................................... 6 
AVAILABLE COMMANDS ......................................................................................................................... 6 
TOOLS....................................................................................................................................................... 7 
HELP ......................................................................................................................................................... 7 
CHANGE PASSWORD ............................................................................................................................. 8 
SIGN OUT ................................................................................................................................................. 8 
QUIT .......................................................................................................................................................... 8 

PREPARING TO DICTATE ........................................................................................................................... 9 
MICROPHONE SELECTION .................................................................................................................... 9 

Microphone ............................................................................................................................................ 9 
Keyboard .............................................................................................................................................. 10 
Philips Speech Mike ............................................................................................................................. 10 
Microphone Calibration ........................................................................................................................ 11 
Train Your Voice Profile ....................................................................................................................... 11 
Microphone Status ............................................................................................................................... 11 

DICTIONARY .......................................................................................................................................... 12 
ADDED WORDS ..................................................................................................................................... 12 
EXCLUDED WORDS .............................................................................................................................. 13 
REPLACEMENT RULES ......................................................................................................................... 13 

ERROR CORRECTION .............................................................................................................................. 14 
In-Line Correction ................................................................................................................................ 14 
Error Correction Window ...................................................................................................................... 14 

DOMAIN SELECTION ................................................................................................................................ 17 
COMMANDS ............................................................................................................................................... 18 

ADD GROUP ........................................................................................................................................... 18 
ADD COMMAND ..................................................................................................................................... 19 



 

 

DELETE ................................................................................................................................................... 19 
SAVE ........................................................................................... ERROR! BOOKMARK NOT DEFINED. 
REVERT ...................................................................................... ERROR! BOOKMARK NOT DEFINED. 

OPTIONS .................................................................................................................................................... 20 
SUGGESTED DICTATION HABITS ........................................................................................................... 21 

HANDHELD DICTATION DEVICES ....................................................................................................... 21 
SPEECH COMMANDS ............................................................................................................................... 22 

ADDITIONAL SPEECH COMMANDS ..................................................................................................... 22 
PUNCTUATION & SYMBOLS SPEECH COMMANDS .......................................................................... 23 

M*MODAL FLUENCY EDITOR................................................................................................................... 24 
EDIT MENU ............................................................................................................................................. 24 
FORMAT MENU ...................................................................................................................................... 25 
TOOLBAR ............................................................................................................................................... 25 
CONTEXT MENU .................................................................................................................................... 26 
SPELL CHECK CORRECTION .............................................................................................................. 27 
AUTOCOMPLETE ................................................................................................................................... 27 
LOOK UP ................................................................................................................................................. 27 

FLUENCY EDITOR DICTATION COMMANDS .......................................................................................... 28 
HELP .................................................................................................................................................... 28 
SELECTING AND CORRECTING ....................................................................................................... 28 
FOLLOW-UP SELECTION .................................................................................................................. 28 
CLEAR SELECTION ............................................................................................................................ 29 
LIST ...................................................................................................................................................... 29 
LINE AND PARAGRAPH ..................................................................................................................... 29 
UNDOING AND DELETING ................................................................................................................ 29 
CAPITALIZING .................................................................................................................................... 30 
Editing and Formatting Text ................................................................................................................. 30 
Navigating the Document .................................................................................................................... 31 



computer assisted coding integration guide 1 

 

 

W E L C OM E  

O V E R V I E W  

Fluency Direct is a desktop solution for free-form dictations of medical reports into windows and web 
based Electronic Medical Records (EMRs).   
 
The core of Fluency Direct is the power of Speech Understanding.  This unique, proprietary technology 
combines best in class speech recognition with a powerful Natural Language Understanding (“NLU”) 
capability for improved accuracy by pairing language models and the context of words.   
 
Speech Understanding allows clinicians to speak to clinical applications in conversational tones, a new 
paradigm M*Modal refers to as Conversational Documentation.  The system continually learns based 
on previous dictation and can even benefit from historically dictated and transcribed reports to accelerate 
the system’s learning and adaption process. 
 
User and facility level customizations and trained author profiles are hosted over the internet in M*Modal’s 
data centers making easy access to trained author profiles from the office, clinic, nursing unit and home.  
This server-based model for speech processing allows for the frequent and seamless upgrade of the 
technology.  The system is not an “install once and upgrade every three years” type of system.  The 
backend speech-processing engine is updated and improved frequently. 

B E N E F I T S  

• Ready to use in minutes 
• Physicians can speak in conversational tones 
• Instant conversion of dictation into medical reports 
• Coverage across all specialties   
• Continuous Learning for Continuous improvement  
• Can be used with third-party software, such as MS Outlook, Word and EMRs 
• Ability to define voice enabled commands to automate frequent tasks and normal text 
• Ability to add new/custom vocabulary 

R E Q U I R E M E N T S  

• Microsoft® Windows® XP or higher Windows OS 
• Processor: Intel Core 2 CPU, 1.5 GHz, 1 GB RAM 
• Microsoft® Internet Explorer Version 6 (SP1) or higher 
• Philips SpeechMike Drivers v2.7 if using Phillips Speech Mike 
• Minimum bandwidth for a single user: 256 Kbits/sec, recommended: 512 Kbits/sec 

A B O U T  T H I S  G U I D E  

The Clinician’s Users Guide is written for the clinical users of Fluency Direct; physicians, physician’s 
assistants, radiologist & imaging specialists, and other clinical professionals that dictate patient 
information.   
  
This guide contains instructions regarding the use of Fluency Editor along with a complete list of 
dictation commands for supported applications. 
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G U I D E  C O N V E N T I O N S  

 
File names This manual uses bold text to indicate file names. 

User input  This manual uses bold text to indicate user input.  

Key names  A specific key on the keyboard is indicated in ALL CAPS.  For example: Press 
ENTER to submit your password.  . 

Commands and 
Prompts 

Screen prompts, menu and window names, fields, buttons, boxes, etc. appear in 
bold type.   

Menus  The syntax used to demonstrate accessing a palette or submenu is Menu > 
Submenu.   

Messages Messages in text are shown in italics as follows: No Information Found.  This 
indicates that the words “No Information Found” are displayed in the application. 

Pressing keys 
simultaneously 

This manual uses the following format to indicate that you must press two 
keyboard keys simultaneously to perform the specified task: SHIFT+F5.  This 
indicates that you must press and hold the SHIFT key, and then press the F5 key 
on the keyboard to perform the specified task. 

Ordered 
Procedures 
 

When you need to follow steps in a specific order, it will have numbers next to 
each step, as shown here:  
 

1. Do this first… 
2. Next, you have to do this… 

Information, Tips, 
and Notes 

Information, Tips, and Notes contain helpful advice and other 
information that makes the software easier and more enjoyable to use.   

Cautions & 
Warnings 

CAUTION!    
Cautions warn of potential problems that you will want to avoid.  
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G E T T I N G  STA RT E D  

O P E N I N G  F L U E N C Y  D I R E C T  

Once you have successfully installed Fluency Direct, 
you can open Fluency Direct by going to Windows 
Start > MModal > Fluency Direct.     
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Fluency Direct application will open; you will see the Splash screen appear while the application 
loads.   

 
 
 
 
 

 

 

Fluency Direct splashscreen
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S I G N  I N  

If you are signing in for the first time or if you have signed out, the Control Bar will be available for you to 
sign in.  Enter your Login Name and Password and click the Sign In button to access Fluency Direct. 

 
 
 
 
   

 

 

 
 
The Control Bar will notify users of the application status.  Error Messages will appear above or below the 
Control Bar, depending upon the position of the Control Bar on the desktop.  Error messages will be 
displayed for a short time before fading away.  
 
 Error Message Example: 
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F LU E N C Y  D I R E C T  W O R K S PA C E  

T H E  C O N T R O L  B A R  

 
After opening the Fluency Direct application, the Control Bar will appear on the desktop.   
  
You can drag the Control Bar to any location on the screen or you can dock it on any edge of the screen 
that you prefer.  To dock the Control Bar, click and drag to a screen edge (the screen edge will become 
highlighted when you near it).  Drop it where you want the Control Bar to be docked.  Fluency Direct will 
remember the location of the Control Bar and will open in the same position each time you log in. 
 
From the Control Bar’s drop down menu, you can access the Tools Menu, which contains all of the 
settings.  You can also access the Help Menu for User Guides and Help, open Fluency Editor, view 
Available Speech Commands, Change Password, Sign Out, or Quit Fluency Direct. 
 
 

 

 

 

 

 

 

 

  

Floating toolbar Toolbar docked to the top

Toolbar docked on
the left side 

Toolbar with open menu



computer assisted coding integration guide 6 

 

 

F L U E N C Y  E D I T O R  

The Fluency Editor is an integrated application that allows you to dictate into, create text snippets, copy, 
paste, and edit.  The benefit of Fluency Editor over the standard text/note pad is that Fluency Editor can 
also respond to a pre-defined set of voice commands.   
 

 
 

 

A V A I L A B L E  C O M M A N D S  

This option will provide you with commands that you can say based on the application that you are 
dictating.  The Available commands window can be turned on (checked) or off from the Control Bar menu.  
 
The Available Commands pop-up window will appear in the bottom right-hand corner of your screen.  
When you hover over a command, you will see alternative commands for each available command as 
well. 
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T O O L S   

This option offers multiple functionalities for customizing your Fluency Direct experience.  
 
Configure the Dictionary (Added Words, Excluded Words, Replacement Rules), select recognition 
Domains, create Commands (Macros), configure Microphone (Settings and Calibration), perform Profile 
Training, and select the Options for dictation display. 

  

H E L P  

User Manual 
The Fluency Direct User Guide is a 
comprehensive Clinician Guide for using 
Fluency Direct.   
 
Quick Start Guide 
The Quick Start Guide will assist you in logging 
into the system and getting started with the 
application; microphone configuration and basic 
functionality.  
 
HELP 
You can access Fluency Direct Help files by 
pressing the F1 key any of the Tools windows.  
You can also access the Help files by going to 
Help > Help from the Control Bar. 
 
Feedback 
This option will allow you to send an email to our Product Development Group offering specific feedback 
and comments regarding the applications features, functionalities, and overall use.  This option is not to 
be used for support or service. 
 
About 
This option will display the Fluency Direct splashscreen, which provides information regarding the current 
installation, and version number, which is required for support tickets. 
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C H A N G E  P A S S W O R D  

The Change Password button will allow users to change their password, as desired.  Enter the Old 
Password, Enter the New Password, and Confirm the New Password for the changes to take effect. 

 

 

S I G N  O U T   

Sign out from the Fluency Direct application using this option; this option will not exit the application, it will 
remain running on your desktop. 

 

Q U I T  

To exit the application completely (the Control bar will no longer be available on your desktop), select Quit 
from the Control Bar menu. 
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P R E PA R I N G  TO  D I C TAT E  
Before you can start dictating, there are a few steps to perform.  To begin with, you will need to set up 
your microphone using the Microphone Configuration option.  In addition, you will need to set your 
hotkeys for recording (if desired) as well as perform enrollment (optional). 

M I C R O P H O N E  S E L E C T I O N   

The first time that a user logs into FLUENCY DIRECT on a workstation, they will be required to perform 
the Microphone Selection.   
 
You can also select Tools > Microphone > Settings from the Control Bar to select a new microphone at 
any time. This will set the recording and playback device as well as set the recording microphone gain.   
Connect the microphone and speakers to your computer, following manufacturer’s instructions.  
 

M I C R O P H O N E   

Select your recording device from 
the dropdown menu.   
 
 
 
 
 
 
 
 
 
 
 
 

If you have selected a 
Windows Default Device, 
you will receive the 
following warning.  This is 

due to a device access conflict.  
You can continue, but if you 
experience problems, it is 
recommended that you return to 
the Microphone Configuration 
Wizard and change your settings. 
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K E Y B O A R D   

This setting will allow you to define specific key presses for recording, commands, and dictation.  
Keyboard hotkeys offer you a convenient alternative for activating the record mode; hotkeys can be used 
with the SpeechMike or Open Mic, as well as additional recording devices. 
 

• Mode: Select "Push to Talk" or "Toggle to Talk" to select your recording mode. 
  

• Push to Talk Use this option when you will be using the microphone sporadically and 
you wish to use the push button to activate the microphone. 
 

• Toggle to Talk.  This option allows you to select a key press, which will begin your 
recording session; used with open microphones and headsets.  

 
• Record: The “Record” hotkey will toggle recording mode on and off.  You can set any 

combination of keys to use as your custom “Record” hotkey by selecting the current key 
combination and pressing the desired key combination.  You can use a single key or a 
combination of keys, as desired. The “Record” hotkey is best used when working with open 

microphone recording mode, but is always available; even when using the push to talk mode.  
 
NOTE: The “Record” hotkey is best used when working with open microphone recording mode, 
but is always available; even when using the push to talk mode.   
 

• Record Commands: The “Record Commands” hotkey will activate the Commands Only 
feature.  When active, all dictation will be treated as commands only. 

 
• Record Dictation: The “Record Dictation” hotkey will activate the Dictation Only feature.  When 

active, all dictation will be treated as dictation only. 
 

P H I L I P S  S P E E C H  M I K E  

This setting will allow you to define specific buttons on the Philips Speech Mike for recording, commands, 
and dictation. 
 

• Mode: Select "Push to Talk" or "Toggle to Talk" to select your recording mode. 
  

• Push to Talk Use this option when you will be using the microphone sporadically and 
you wish to use the push button to activate the microphone. 
 

• Toggle to Talk.  This option allows you to select a key press which will begin your 
recording session; used with open microphones and headsets.  

 
• Record: Define a SpeechMike button that will toggle recording on and off. 

 
• Record Commands: Define a SpeechMike button that will activate the Commands Only feature.  

When active, all dictation will be treated as commands only. 
 

• Record Dictation: Define a SpeechMike button that will activate the Dictation Only feature.  
When active, all dictation will be treated as dictation only.  
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M I C R O P H O N E  C A L I B R A T I O N  

The next step will be to adjust your microphone.  
Microphone calibration will control the volume level of the 
input source.  This is not the same as the volume slider, 
which controls the volume level of speakers.   
 
The calibration process will adjust automatically as you 
read the paragraph included on the wizard.  It will require 
a minimum of 20 seconds of audio to adjust the gain 
properly.   
  
At this point, you will begin recording.  If you are not 
familiar with the recording buttons of your device, 
please take a few minutes to review the location of 
your Record button.  When set to “Push to Talk” you 
will need to press and hold the Record button during 
your sessions.  See page 15, the Microphone Tab for 
more information about recording options. 
 
Once you have finished reading the paragraph, you can 
click Next, which will take you to the Voice Training.   

 

T R A I N  Y O U R  V O I C E  P R O F I L E  

Training your voice profile, or enrollment, is a simple 
process.  Once you login as a new user, you have the 
option to complete the enrollment process after you have 
selected and calibrated your microphone.  This is 
recommended for best recognition results, but is not 
required to run the program.   

 
For optimal recognition, M*Modal recommends 
10 minutes of dictation (but it is not required).   
 
The Voice Training window will display text to 

be dictated.  As you complete each page of narrated text, 
a new narrative will appear.   
 
Once you have finished training, click Save to save your 
voice profile.  You can return at any time to continue the 
training process.  
 

M I C R O P H O N E  S T A T U S  

Once you begin recording, you will see the microphone on the 
Control Bar light up green.  A green bar will show around the 
bottom of the Control Bar, moving left to right, to display an 
indication of the microphone volume.  
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D I C T I O N A R Y  

The Dictionary screen allows you to Add Words, Exclude Words, and create Replacement Rules.   
 

 

A D D E D  W O R D S  

Fluency Direct allows users to create a custom dictionary of words or phrases.  By adding words, users 
can improve recognition of names, locations, and medications. 
  
To add a new word, select the Added Words radio button 
and click the Add button. 
 
Type the word that you wish to add in the blank field.   
 
To improve recognition you can Record Pronunciation of 
the added word.  Click.  This will ensure proper 
recognition from the system. 
 
You can also control how the term is used by defining the 
type of word. You can set it as a Name, Location, 
Medication, or Other.  
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E X C L U D E D  W O R D S   

Fluency Direct allows the user to specify words that he or she may never want to appear in the dictation, 
for a variety of reasons.  To exclude a word, select the Excluded Words radio button and click Add.   
 
Type the word that you do not wish to see in the dictation and click Save.  You can edit or delete the 
excluded words at any time. 
 

 

R E P L A C E M E N T  R U L E S  

Fluency Direct also allows users to create a collection of words or phrases that will be used to substitute 
the spoken form.  To create a Replacement Rule, select the Replacement Rules radio button and click 
Add. 
 

 
 
Original Word 
Enter the original word in this field (example: cabbage) 
 
Replace With 
Enter the text that you want to see when that word is spoken (example: CABG) 

 
WARNING!   
Be careful when using the replacement text; it is not a substitute for training a word that 
receives poor recognition.   
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E R RO R  C O R R E C T I O N  
There are two ways to perform error correction with Fluency Direct: In-Line Correction using the phrase 
“Select <text>” or Error Correction using the phrase “Correct <text>”.   

I N - L I N E  C O R R E C T I O N  

In-line correction only makes a change to the text in the current documentation.  On occasion Fluency 
Direct might misrecognize a spoken word or phrase.  This misrecognition is not necessarily, because a 
word or phrase is missing from the underlying vocabulary domain or user dictionary, but could be 
because of other factors such as background noise or spoken tone.  To perform in-line error correction, 
you can select the text that you want to correct and then speak over the text. 
 
Example: 
Dictate your text; see the error… 

 
 
 
Speak “Select Fibroma” or use the keyboard and mouse to highlight text… 
 

 
 
Speak “Fibromyalgia” and the text is replaced… 
 

 
E R R O R  C O R R E C T I O N  W I N D O W  
 
At this time, Error Correction is only supported in Fluency Editor, MS Word, EpicCare, Allscripts, 
McKesson, and Practice Partner. 
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If you routinely notice the system making the same errors repeatedly, there might be a problem with the 
underlying vocabulary domain.  The misrecognized word or phrase might not be part of the domain or the 
domain has never seen the desired word or phrase before in the existing context.  By using the error 
correction window, you can force Fluency Direct to learn new words and phrases to react properly every 
time the newly learned utterance appears in dictation. 
Example: 
Dictate your text; see the error… 
 

 
 
Speak “Select Fibroma” or use the keyboard and mouse to highlight text… 
 

 
 
Speak “Correct Selection” to trigger the error correction dialog.  The Error Correction dialog will appear…   
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Fluency Direct will display suggestions based on the word being corrected.  From here, you can select a 
replacement option suggested by saying “Choose 1,” “Choose 2,” “Choose 3,” and so on. 
 
The suggested replacements are derived from a list of words detected with a phonetic similarity and in a 
similar context.  Over time, information is gathered regarding the specific speech patterns of the dictator 
as well the context of words previously spoken.  In this way, the system learns not only from 
annunciations, but also learns from the historical context of words used by the document author. 
 
If none of the suggestions meet your needs you can type in the correction dialog using the keyboard.  
 
As you make changes to the word or phrase, and that word or phrase is not available in the current 
vocabulary domain, you will be given an option to record the pronunciation, to improve recognition.  
Selecting the type of word will also improve future recognition. 
 
Say “Save” or click the Save button to finish. 
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D OM A I N  S E L E C T I O N  
Domain Selection is used to ensure recognition.  The default domain is General Medicine.  Users have 
the option to select specific vocabulary domains related to their field.  Each domain will download and 
install a specific recognizer that increases accuracy and speed of recognition. 
 

 
 
We recommend that you select your 
specific domain, or most common 
domain, prior to enrollment.  As you 
are working, you can switch domains 
to ensure the best recognition 
possible.   
 
To install a domain, click the install 
button next to the desired domain.  
Fluency Direct will download and 
install that specific domain.   
 
Once additional domains are available, 
you can choose the desired domain by 
selecting the radio button next to that 
domain name. 
 
 

  



computer assisted coding integration guide 18 

 

 

C OM M A N D S  
Fluency Direct offers the ability to create commands to which can be used to insert snippets of text, 
perform keyboard shortcuts, and more.  Commands are organized by Groups.  To create a Command, 
you must first assign it to a Command Group. 

A D D  G R O U P  

Click the green Add button arrow to create a new Command Group.  Select the Add Group option.  
You will be prompted to enter a NAME for the new command in the list box.  Once the name has 
been entered, click the ENTER key and the Group Panel will appear. 

 

 
 
For each Group, you can enter the Spoken Form and the Window Title. 
 

• Activation: Always Active 
If the Always Active checkbox is checked this group of commands will be available for all 
applications or windows.  If it is unchecked, then the Window Title option will become active, 
allowing you to specify the name of the window title that will activate the group of commands. 
 

• Only for Window Title  
Specifying a Window Title will enable the Commands associated with this group, when a 
window containing the title in its title bar becomes active.   
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A D D  C O M M A N D  

Highlight the desired Command Group, and then click the green Add button dropdown to create a 
new command for that group.  Select the Add Command option.  You will be prompted to enter a 
NAME for the new command in the list box.  Once the name has been entered, click the ENTER 

key and the Actions Panel will appear. 
Spoken Form 
You have the option for entering a spoken form if your Command Name is unrecognizable.  For example: 
“CABG” would be “cabbage” in the Spoken form. 
New Action 
To enter the action for the Command, click the green Add Action button and choose from the following 
options.  A command can contain multiple actions. 
 

• Simulate Key Presses 
This option will capture your keystrokes and record them as 
the command.  If you wish to change a key press, you will 
need to highlight the key press that you wish to remove, and 
then press the new keys.  If you wish to remove a key 
press, you will need to highlight the key press, right-click the 
mouse and select Delete Selection. 
 

• Wait 
This option will cause the system to wait for a specified amount of time before proceeding to the 
next action. 
 

• Script 
This option will insert a pre-written script of code that will allow you to perform more complicated 
functions. 
  

• Text Snippet 
This option will insert a snippet of text during dictation when you say the name of the command.. 
  

Delete Action 
To remove an action from the command, select the action in the command and click the red Delete 
action button. 

Moving Action 
To move an action up or down in the action list, select the action and click the up or down arrow 
buttons.  For example, you entered the canned text for the command and then added the open 
mail command; you can add the key presses and move the action to the top of the action list.  

D E L E T E   

Click the red Delete button to delete the selected command or group. 
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O P T I O N S  
The Options tab provides additional options related to the display and rendering of the dictation and draft 
text.  More options may be added in the future. 
   

 
 
DATE AND TIME 
 

• Date 
Select the format that you wish to see dates appear in your dictation 

• Time 
Select the format that you wish to see times appear in your dictation. You can choose 12hr or 
24hr format 

 
MISCELLANEOUS 
 

• Automatically Sleep 
This option will set the number of minutes of recorded silence before the system will automatically 
go to sleep.  Enter “0” to disable this option. 

• Cranial 
Select Arabic (1-12) or Roman (I – XII)for the formatting of cranial nerve numbers 

• Partial Results 
Select True to display partial recognition results at the cursor instead of at the bottom-right corner 
of the screen.  Select False to turn off Partial Results 

 
SPACING 
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• Insert Spaces 

Set the number of spaces (1 or 2) to insert at the end of sentence punctuation, between 
sentences. 

• Measurement 
Select Space Separated (21 cm) or Non-Space Separated (21cm) for the display of 
measurements 

• New Paragraph 
Set the number of <Return> key presses that will be inserted when you say “New paragraph”    

 
SYMBOLS 
 

• Numerical Range 
Select the display of numerical ranges: 1-10, 1 to 10, or one to ten 

• Percent 
Choose to display the percent symbol” %” or the text “percent” 

• Temperature 
Choose to display the degree symbol “ ”or the text “degree” 

S U G G E ST E D  D I C TAT I O N  H A B I TS   

H A N D H E L D  D I C T A T I O N  D E V I C E S  

• If using a handheld dictation device, place in the palm of your hand with the thumb on the 4-position 
switch and your index finger across the trigger underneath.  

 
• When dictating, hold the device approximately 1 inch from your mouth.  When turning your head, 

please remember to move keep the microphone near your mouth. 
 
• When using the Push-To-Talk mode, pause slightly before speaking when starting your recorder and 

pause briefly before stopping recording.  This prevents words from being “clipped.”  
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S P E E C H  C OM M A N D S   
The following is the list of commands supported in Microsoft Word and Fluency Editor. 
 
SAY THIS… TO DO THIS…

select <word sequence> Select a word or group of words; 5 word limit, including 
punctuation 

Correct <that> Correct a selected word or phrase 

Boldface <that>  Apply boldface formatting to a selected word or phrase 

  

Copy <that> Copy a selected word or phrase 

Paste <that> Paste a selected word or phrase 

Delete <that> Delete a selected word or phrase 

Undo <that> Undo the previous action 

Uppercase <that> Apply Uppercase formatting to  a selected word or phrase 

Lowercase <that> Apply lowercase formatting to a selected word or phrase 

New Line / Paragraph 
 

Start selected text on a new line/paragraph or create a new 
line/paragraph at the current cursor position 

Next Line / Paragraph Move to the next line/paragraph following the current 
line/paragraph. 

Insert Line / Paragraph Insert a new line/paragraph from the cursor position. 

  

A D D I T I O N A L  S P E E C H  C O M M A N D S   

The following is a list of commands supported in Epic, Allscripts, McKesson, and Practice Partner. 
 
SAY THIS… TO DO THIS… 

select <word sequence> Select a word or group of words; 5 word limit, including 
punctuation 

Correct <that> Correct a selected word or phrase 

Correct selection  Correct a selected word or phrase 
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Copy <that> Copy a selected word or phrase 

Paste <that> Paste a selected word or phrase 

Delete <that> Delete a selected word or phrase 

Undo <that> Undo the previous action 

P U N C T U A T I O N  &  S Y M B O L S  S P E E C H  C O M M A N D S  

The following is the list of commands for dictating punctuation and symbols. 
 
SAY THIS… TO DO THIS… 

colon Insert a colon : in the dictation 

semi colon Insert a semi-colon ; in the dictation 

open parentheses Insert the open parentheses ( in the dictation 

Closed parentheses Insert the closed parentheses ) in the dictation 

Opening quotation Insert the opening quotation marks “ in the dictation 

Closing quotation Insert the closing quotation marks ” in the dictation 

Period Insert a period . in the dictation 

Slash Insert a slash \ in the dictation 

Question mark Insert a question mark ? in the dictation 

Exclamation mark Insert an exclamation ! mark in the dictation 

point Insert a period for temperatures  
(ex. 98.6, say ninety-eight point six) 
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M * MO DA L  F LU E N C Y  E D I TO R   

E D I T  M E N U  

The Edit menu allows you to access the editing options for use in the draft document. 

FUNCTION SHORTCUT DESCRIPTION 

Undo CTRL + Z Use this function to undo the last action done.  

Redo CTRL + Y Use this function to redo a function that you have undone.  

Cut CTRL + X Use this function to cut selected text from the document.  

Copy CTRL + C Use this function to copy selected text from the document.  

Paste CTRL + V Use this function to paste selected text into the document that 
has been cut or copied.  

Delete DEL Use the Delete key on your keyboard or this option to delete the 
selected text. 

Select All CTRL + A Use this function to select all text in the document.  

Find CTRL + F Use this function to find a specific word or phrase.   

Delete Left 
Word  Use this function to delete the word to the immediate left of the 

cursor.   

Delete 
Right Word CTRL + DEL Use this function to delete the word to the immediate right of the 

cursor.   

Auto 
Complete TAB 

When editing, as you are typing Fluency Direct will offer 
suggestions based on your word entry.  To use the suggestion 
provided, press TAB and it will automatically complete the word 
for you. 

Auto 
Complete 
Popup 

SHIFT + TAB 
Fluency Direct will only show one suggestion based on your word 
entry; by pressing SHIFT + TAB, you will see a popup window 
with multiple suggestions that you can choose from. Use your 
mouse to select. 

Correct Left 
Errors BACKSLASH 

Automatically corrects spelling errors to the left of the cursor.   
 
WARNING!  This feature will not provide options, be sure that 
it is correcting to the word that you want to appear. 
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F O R M A T  M E N U    

The Format menu allows you to access the formatting options that can be applied to the draft document. 

FUNCTION SHORTCUT DESCRIPTION 

List CTRL + L 
This function will create a list for the selected text or from where 
the cursor is placed.  The shortcut key for this function is 
CTRL+L. 

Bookmark CTRL + SHIFT + F5 
This function will insert a highlighted bookmark of the selected 
text for QA.  This bookmark can be typed freeform as opposed to 
the pre-defined bookmarks located under the Insert menu.  The 
shortcut key for this function is CTRL+B. 

Bold CTRL + B This function will make the selected text Bold.  

Italic CTRL + I This function will make the selected text Italicized. 

Underline CTRL + U This function will make the selected text Underlined.  

Toggle 
Case SHIFT + F3 

This function will toggle selected text between lower case, Title 
Case, and UPPER CASE.  The shortcut for this function is 
CTRL+U. 

Decrease 
Indent CTRL + SHIFT + M This function will decrease the indent of a listed item.  The 

shortcut key for this function is CTRL+Shift+M.   

Increase 
Indent CTRL + M This function will increase the indent of a listed item.  The 

shortcut key for this function is CTRL+M.  

 

T O O L B A R  

The toolbar offers quick access through icons to the most 
commonly used functions in the Format menu. 

FUNCTION SHORTCUT DESCRIPTION 

List CTRL + L 
This function will create a list for the selected text or from where 
the cursor is placed.  The shortcut key for this function is 
CTRL+L. 

Bookmark CTRL + SHIFT + F5 
This function will insert a highlighted bookmark of the selected 
text for QA.  This bookmark can be typed freeform as opposed to 
the pre-defined bookmarks located under the Insert menu.  The 
shortcut key for this function is CTRL+B. 

Bold CTRL + B This function will make the selected text Bold.  

Italic CTRL + I This function will make the selected text Italicized. 

Underline CTRL + U This function will make the selected text Underlined.  



computer assisted coding integration guide 26 

 

 

Decrease 
Indent CTRL + SHIFT + M This function will decrease the indent of a listed item.  The 

shortcut key for this function is CTRL+Shift+M.   

Increase 
Indent CTRL + M This function will increase the indent of a listed item.  The 

shortcut key for this function is CTRL+M.  
 
 

C O N T E X T  M E N U  

You can access the Context menu by right clicking on any text the Fluency Editor workspace. 
 
The Context menu will provide you with 
available spelling options (if the cursor is 
placed in a misspelled word.  Additional 
spelling options allow you to Ignore, Ignore 
All, Correction (this will open the spelling 
Correction dialog), Undo, Cut, Copy, 
Paste, Delete, Select All, or Lookup.  
Lookup option will allow you to search the 
word online. 
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S P E L L  C H E C K  C O R R E C T I O N  

 
The Fluency Editor offers a built in spell check correction that; you can access spell check by right clicking 
on the word and selecting Correction.  The following window will appear. 
 
From here you can select the correct word from the Suggestions box, choose to Ignore a single word or 
All instances of a word or you can enter a new spelling and click Change.   
 

 

A U T O C O M P L E T E  

The Fluency Editor offers an auto-complete 
option when typing words.  As you are typing the 
word, suggestions will appear.  Click TAB to 
select the word shown or SHIFT+TAB to see a 
selection of available words.  You can select a 
word using the arrow keys and pressing 
ENTER. 
 

L O O K  U P  

The look-up option allows you to check 
medications, obtain a definition, or verify 
correct spelling from a list of online 
resources. 
 
Right click the word and select your online 
source from the Look up option. 
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F LU E N C Y  E D I TO R  D I C TAT I O N  C OM M A N D S  
The following speech commands are supported in the M*Modal Fluency Direct Fluency Editor.  There is 
variable functionality within other word process editors and applications.   

HELP  
Click F1 from the Fluency Direct application to access the context sensitive help. 

SELECTING AND CORRECTING  
SAY THIS… TO DO THIS… NOTE… 

select <word sequence> Select a word or group of words; 5 word 
limit, including punctuation 

CDS Live will find exact matches, as well 
as any related match.  It will select the first 
available instance after the cursor. 

correct <word sequence> Correct a word or group of words  

select <word> through <word> Select the text beginning with the first 
word spoken through to the last word 
spoken. 

 

correct <word> through 
<word> 

Correct the text beginning with the first 
word spoken through to the last word 
spoken. 

 

select all Select all text in the entire document.  

FOLLOW-UP SELECTION 
SAY THIS… TO DO THIS… NOTE… 

select next  
select next one 
next one 

Select the next instance of the currently 
selected text.   
 
 

Can be used with: 
Sentence, List Item, Paragraph, or Line. 
 
 This command requires the use of “Select 
Current <x>” first. 

select previous 
select previous one 
previous one 

Select the previous instance of the 
currently selected text.  
 
 

Can be used with: 
Sentence, List Item, Paragraph, or Line  
 
This command requires the use of “Select 
Current <x>” first. 

select next <n> words Select the number of words (between 2 
and 9, including punctuation) to the right 
of the cursor. 

Cannot use the Next One commands in 
conjunction with this command. 
 
The cursor must be at the beginning or 
end of a word to use this command 
properly. 

select previous <n> words Select the number of words (between 2 
and 9, including punctuation) to the left of 
the cursor. 

Cannot use the Previous One commands 
in conjunction with this command. 
 
The cursor must be at the beginning or 
end of a word to use this command 
properly. 
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CLEAR SELECTION 
SAY THIS… TO DO THIS… NOTE… 

clear selection Clear the selected text. Cursor will be positioned at the end of 
the selection, once cleared. 

unselect text Deselect the selected text.  

unselect that Deselect the selected text.  

LIST  
SAY THIS… TO DO THIS… NOTE… 

item <n> <word sequence> Begin a list at the current cursor position 
with the first list item. 

Continue with Item <n> until complete. 

item number <n> <word 
sequence> 

Begin a list at the current cursor position 
with the first list item. 

Continue with Item Number <n> until 
complete. 

<word sequence> next item 
<word sequence> 

Begin a list at the current cursor position 
with the first list item. 

Next Item command continues the list. 

   

   

LINE AND PARAGRAPH  
SAY THIS… TO DO THIS… 

new line/paragraph 
 

Start selected text on a new line/paragraph or create a new line/paragraph at the current 
cursor position 

next line/paragraph Move to the next line/paragraph following the current line/paragraph. 

  

select current line/paragraph Select the current line/paragraph in which the cursor is currently positioned. 

UNDOING AND DELETING  
SAY THIS… TO DO THIS… NOTE… 

delete selection  
delete current selection 

Delete the currently selected text. All delete commands ensure proper 
spacing and case at the location of the 
deletion. 

delete current sentence Deletes the entire sentence in which the 
cursor is currently positioned. 

 

delete next <n> words Delete a specified number (between 2 and 
10 words, including punctuation) of words 
to the right of the cursor position. 

If the cursor is positioned within a word, it 
will use that word as the first word. 

delete previous <n> words Delete a specified number (between 2 and 
10 words, including punctuation) of words 
to the left of the cursor position. 

If the cursor is positioned within a word, it 
will use that word as the first word. 



computer assisted coding integration guide 30 

 

 

undo that  
undo last 
undo last command 

Undo last command spoken.  

CAPITALIZING  
SAY THIS… TO DO THIS… NOTE… 

lowercase/no caps selection Turns current selection into lowercased 
text 

 

lowercase/no caps next <n> 
words 

Lowercases the sequence of <n> tokens 
to the left of the current cursor position 

Can select between 2 and 10 words, 
including punctuation 

lowercase/no caps previous 
<n> words 

Lowercases the sequence of <n> tokens 
to the right of the current cursor position 

Can select between 2 and 10 words, 
including punctuation 

uppercase/all caps selection Turns current selection into uppercased 
text 

 

uppercase/all caps next <n> 
words 

Uppercases the sequence of <n> tokens 
to the left of the current cursor position 

Can select between 2 and 10 words, 
including punctuation 

uppercase/all caps previous 
<n> words 

Uppercases the sequence of <n> tokens 
to the right of the current cursor position 

Can select between 2 and 10 words, 
including punctuation 

E D I T I N G  A N D  F O R M A T T I N G  T E X T   

SAY THIS… TO DO THIS… NOTE… 

boldface selection Turns current selection into boldfaced text  

boldface next <n> words Boldfaces the sequence of <n> tokens to 
the left of the current cursor position 

Can select between 2 and 10 words, 
including punctuation 

boldface previous <n> words Boldfaces the sequence of <n> tokens to 
the right of the current cursor position 

Can select between 2 and 10 words, 
including punctuation 

italicize selection Turns current selection into italicized text  

italicize next <n> words Italicizes the sequence of <n> tokens to 
the right of the current cursor position 

Can select between 2 and 10 words, 
including punctuation 

italicize previous <n> words Italicizes the sequence of <n> tokens to 
the left of the current cursor position 

Can select between 2 and 10 words, 
including punctuation 

underline selection Turns current selection into underlined 
text 

 

underline next <n> words Underlines the sequence of <n> tokens to 
the left of the current cursor position 

Can select between 2 and 10 words, 
including punctuation 

underline previous <n> words Underlines the sequence of <n> tokens to 
the right of the current cursor position 

Can select between 2 and 10 words, 
including punctuation 
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N A V I G A T I N G  T H E  D O C U M E N T   

SAY THIS… TO DO THIS… 

scroll up Scrolls up 

scroll down Scrolls down 

insert after <word> Places cursor after the given word in insert mode 

insert after <word sequence> Places cursor after the given word sequence in insert mode 

insert before <word> Places cursor before the given word in insert mode 

insert before <word sequence> Places cursor before the given word in insert mode 

go to <start/begin/beginning> 
of <sentence/paragraph> 

Places cursor at the beginning of the current sentence, paragraph, or list 

move to 
<start/begin/beginning> of 
<sentence/line/paragraph> 

Places cursor at the beginning of the current sentence, line, paragraph, or list 

go to <end/ending> of 
<sentence/line/paragraph> 

Places cursor at the end of the current sentence, line, paragraph, or list 

move to <end/ending> of 
<sentence/line/paragraph> 

Places cursor at the end of the current sentence, line, paragraph, or list 

 

 

 


